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Using MDHT Tool

Preparing for MDHT

Model Driven Health Tools (MDHT) is an open source application to promote interoperability in the
development of a shared electronic repository of CDA templates and documents. It promotes shared
artifacts between related healthcare standards, and supports the work to develop customized CDA-
based document specifications for specific needs. Its other advantage is providing the framework that
seamlessly integrates design, publication, and instance generation. The work involved in creating
CDA template usually requires a cross project team consisted of epidemiologists, laboratorians,
clinicians, standards developers, and information systems specialists. Specifically, it is advisable that
the model development team comprises of the following skill areas:

« Programming interface background and experience with the Eclipse IDE
Public health subject matter expertise

« Vocabulary/terminology experience to look up appropriate codes

« CDA knowledge/experience

To learn how to use MDHT, the Open Health Tools MDHT project site provides many resources
including Guides and Tutorials, supplemental downloads, and MDHT Releases and Downloads. The
MDHT documentation includes:

This Using MDHT to create PHCR guide does not replace any of the current MDHT guides and
tutorials, and supplements them with information about the process for using MDHT to edit and
create public health case reports (PHCR).

Installing the Eclipse software

Open Health Tools provides an MDHT Getting Started Guide that provides detailed steps for the
installation of the most current release of the MDHT All-In-One windows software, and describes
how to setup a new CDA-based model project. Please refer to that for the latest in-depth instructions
on how to setup your environment for MDHT. The following provides a summary guideline on the
process of installing and setting up MDHT for PHCR.

Windows

Download the all-in-one package to install from the MDHT project website at:
https://www.projects.openhealthtools.org/sf/projects/mdht/)

You will need to unzip the file in a local directory. Make sure that you do not have spaces in any of
the folder names for the location where the MDHT files are unpackaged. Eclipse may not work well
with folder names that have spaces. An example of a good name is: c:/eclipse

After unzipping the folder, Eclipse is ready to be used.
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Using MDHT Tool
Mac

You will need to download the software and go through step-by-step instructions for complete install.
Check the Open Health Tools website to see if there are any updated mac install instructions. At the
time of printing, the most up-to-date instructions were located at:
https://www.projects.openhealthtools.org/sf/discussion/do/listPosts/projects.mdht/discussion.forum11
36.topc11540;jsessionid=2DB91C372FBF9456B07168CE12318946?pageSize=-1#post_post20216)

Once the software is extracted from the zip file into a folder, run the Eclipse software from the unzip
folder. When it opens, you will see a welcome screen. Close out of the welcome screen such as the
following, with 3 main zones:

® Eclipse File Edit Mavigate Search Project Run UML Editor Window Help @ 0 oy W g = 4) = Fri 7:04 AM G (Charged) Q)
[Nl =UML Modeling: - org.openhealthtaols.mdht.uml.cda.ccd model/model fced.uml - Eclipse - fUsers/. o1/ Documents fworks =

[ Project Explorer 5 % B Ol P ccdumi B

® i = org.openhealthtools. maht.uml.cda 22 4 Tem late edltor FA I A ]
P ly7 > neg apenheaithecals maheumi eda ced 23 oy p = [P P e

Bl G i el L e B I

¥ 5% 0rg.openheaithtools.mdnt.uml.cda.cdt 239 =

¥ o} neg. apenhealthtaals mane uml eda.cdr. mod

¥ b weg.openibealthtosls, mdhtumi cda.consel 170 [k

¥ o} oeg. apenheaithtaals mdnt uml eda cansal made

¥ b weg.openibealthtosls, mdhtum cdaexample 173

¥ L= 0rg.openhealthtools. mdnt.umil.cda.example. do<

¥ 5} neg.openheaithtoals mahe uml eda euample. madel 4

b > trg.openhealthicals mdhtuml eda hitsp 245

¥ 54 0rg.openhealthtools. mdnt.umil.cda. hitsp. fac njec
¥ o7 neg. apenheaithtaals mdnr uml eda_hitsp. model

* i wrgopenhealthtoals.mdht sl cda.ihe

] AdvanceDirectiveObservation 2.16.840.1.113883.10.20.1.17
= AdvanceDirectiveReference 2.06.840.1 113883.10.20.1,36
] AdvanceDirecrivesSectian 2.16.840.1.113883.10.20.1.1
L advanceDirectivestatusDoservat 2.06.840.1 113883.10.20.1.37
] advance Direeriveverificarian 2.16.840.1.113883.10.20.1.56
= AyeObservation 2.16.840.1.113883.10.20.1.38
E alertOnservation 2.06.840.1.113883.10.20.1.18
T alerrssection 2

L] AlertStatasObservation 2

16.840.1.113883.10.20.1.2
.16.840.1.113883.10.20.1.39

7] CauseQfDeathOnsercatian 2.16.840.1.113683.10.20,1.42
e . openhealthtoals. mant L. da * L Comment. 2.16.840.1.113883.10.20.1.40
57 > neg.apenheaithecals, mahe umi b ¥ = ContinuityOfCareBocument 2.16.840.1.113983.10.20.1
> b5 g epenbealthtoals.mdnt uml hiZ.sim » ] Coneragractiviny 2 16.840.1 113883 10.20.1.20
» i ora.cpenhesithtools.mant.umi.hiivocab 1 > ] CoveragePlanbescription
o3 > neg.apenheaithicals maheumi term medels 1 » I Coveredrarty
F i samales ¥ ] Encourneri acatian 2.16.840.1.113683.10.20,1.45

] ottt 15 54 gE3 020

Project explorer

Properties are rot available.

Properties editor/results console

=0 Br
B Oleems selecred

Figure 1 MDHT Screen Zones

The project explorer will list all project files that have been created in the Eclipse workspace.

The Template editor is used to add templates, associations, attributes, constraints etc. It also shows
the summary values for the templates and attributes that are added to the project model

The properties editor and results console is the location where the constraints can be directly edited

Creating an Implementation Guide Model

=k
]

To create a project, go to the project explorer and either a) select the " icon at the top or b) Select

File->New->Project from the application menu:
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Eclipse [[fiGJ Edit Navigate Search Project Run UML Editor Window

5 =
< RS XEN P T project...
Open File...
- £ Example...
oject Explorer Close HEW -
1 org.openhy Close All G EW £4 Other... %N |
1o -

Figure 2 Create New Project

Next, you will need to select a wizard. You should see a folder Model Driven Health Tools with a
wizard named, New CDA Model. Select this wizard and click next.

LeNO New Project
[
| Select a wizard —,

| Wizards:

2% Java Project
4 Java Project from Existing Ant Buildfile
25 Plug-in Project
(= General
> =CVs
¥ = Eclipse Modeling Framework
|| » (= Ecore Tools
| | b = Graphical Modeling Framework
|| »&=ava
| ¥ [z Model Driven Health Tools
| =l New CDA Model
| | P = Plug-in Development
|
|
|

P [=5VN 1
¥ (= Other v
@ < Back ( Cancel ) Finish

Figure 3 New CDA Model Wizard

On the next screen, enter the information for the implementation guide you will be working on. Note
that you should not introduce any spaces in your model name. Use a name that is short and to the
point. For example:
« Implementation Guide Namespace: PHCR
« Document: PublicHealthCaseReport
« CDA Document Conformance Reference: ccd::ContinuityOfCareDocument
« (Consult with Sondra Renly (srrenly@us.ibm.com) for assigned names for the Public Health
CDA project models.)
8006
Open Health Tools

Use to create CDA Implementation Guide Medel Project

Implementation Guide Namespace phcr

Document PublicHeaIthCaseRepor‘L]

CDA Document Conformance Reference | cod:ContinuityOfCareDocument } ¢]
Template ID (Optional)

Assigning Authority (Optional)

Document Base Package org.cpenhealthtools.mdht.cda

Mamespace URI http: [ fwww.openhealthtools.org/mdht/uml/cdafphcr
Document Mamespace Prefix phcr

Package Name publichealthcasereport

Prefix PHCR

Figure 4 New Project Definition Screen
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Using MDHT Tool
There will be a wait for a few minutes while the project is being created.

Once the application completes the task, you will have three folders created in your project explorer
named:

« org.openhealthtools.mdht.uml.cda.<projectname.model>, e.g. phcr.model - This is the
UML model folder for the project you just created. This is where the model will be built -
with the vocabulary details, constraints, etc.

« org.openhealthtools.mdht.uml.cda.<projectname.doc>, e.g. phcr.doc - This uses the
content from the .model project to automatically create a pdf implementation guide (uses a
dita to transform the model into the implementation guide)

« org.openhealthtools.mdht.uml.cda.<projectname>, e.g. phcr - This is the project that is
used to generate the code to produce the project artifacts. The code is used to create the
document, validate the document and process the document. Java code is generated and
compiled in the first project file above.

Remove CDA builder - To temporarily turn off the building of the artifacts until the project is

complete, “Right-click” on the <project name>.doc folder, and from the menu, select add/remove

CDA builder. Without executing this step, every time the model is saved, the process will run the

time-consuming dita transform. This can be turned off temporarily while work on the model

continues, until the model is more fully developed, and then, the transform can be turned back on.
27 Refresh F5 £

Close Project
Close Unrelated Projects

Add/Remove CDA Builder '
Run As > 2
Debug As >

Figure 5 Add/Remove CDA Builder

You will be using the Implementation Guide for CDA Release 2: Public Health Case Reporting,
Release 1 document to build these templates.

Building the Model

You will be building a sample model using the following sample constraints shown in Table 1 below
from the implementation guide for public health case reporting. It provides specific sections that are
required, or optional with specified constraints. The document will have a main document body,
additional sections, with their own observations, etc.:
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Table 1 - Sample statement excerpts from Implementation Guide®

Public Health Case Report CDA R2 template root [ClinicalDocument: templateld 2.16.840.1.113883.10.20.15]

SHALL contain [1..1] code/@code="55751-2" Public Health Case Report (CodeSystem: 2.16.840.1.113883.6.1 LOINC) STATIC
(CONF:546)

SHALL contain [1..1] component/structuredBody (CONF:605), which

SHOULD contain [0..1] component (CONF:914) (specialized branch), which if present
I.SHALL contain [1..1] PHCR Social history section (templateld:2.16.840.1.113883.10.20.15.2.22) (CONF:915)

PHCR Social History Section [section: templateld 2.16.840.1.113883.10.20.15.2.22]

Conforms to CCD Social history section Template (templateld: 2.16.840.1.113883.10.20.1.15).
SHALL contain [1..1] code/@code="29762-2" Social history (CodeSystem: 2.16.840.1.113883.6.1 LOINC) STATIC (CONF:1894)
SHALL contain [1..1] title="Social History" (CONF:1895)
SHALL contain [1..1] text (CONF:1896)
SHOULD contain [0..*] entry (CONF:1897) (specialized branch), which if present
a. SHALL contain [1..1] @typeCode="DRIV" Is derived from (CodeSystem: 2.16.840.1.113883.5.1002
HL7ActRelationshipType) STATIC (CONF:1898)
b. SHALL contain [1..1] Geotemporal history observation (templateld:2.16.840.1.113883.10.20.15.3.3) (CONF:1899)

Geotemporal history observation [observation: templateld 2.16.840.1.113883.10.20.15.3.3]

1. SHALL contain [1..1] @classCode="0OBS" Observation (CodeSystem: 2.16.840.1.113883.5.6 HL7ActClass) STATIC (CONF:420)

SHALL contain [1..1] @moodCode="EVN" Event (CodeSystem: 2.16.840.1.113883.5.1001 HL7ActMood) STATIC (CONF:421)

3. SHALL contain [1..1] code/@code="55210-9" Geotemporal History (CodeSystem: 2.16.840.1.113883.6.1 LOINC) STATIC
(CONF:422)

N

You will first create the document root template. From within the <project name>.model file, select
the <project name>.uml file and double click on it to open the model

¥ l=f > org-openhealthtools.mdht.uml.cda.pher.model 653 [k
¥ & > model 653
[5) pher.properties 224
» *H > pheruml 653

"M > pher-vacab.uml 653
pher-vocab.uml.mine
pher-vocab.uml.r650
pher-vocab.uml.r653

Figure 6 Create Document Root Template Part 1

! Note that a nested SHALL statement beneath a SHOULD becomes a SHOULD because the parent constraint
is optional, meaning that if the parent component exists, then there shall be a social history section.
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# Eclipse File Edit Navigate Search Project Rum UML Editor  Window Help (7] b M 4 T 4 m Fril0:01AM ERoan Q
CYars) <UML Modelings - e —

T =0 W prorem B ==l
! il

T EE W phorund - o openheskhioah mant sl oda. pher madel i model

Figure 7 Create Document Root Template Part 2

Depending on which row you’re on in the template explorer, the properties will change.

From the implementation guide, you will be implementing the document constraints shown in the
Table 1 above. These are the SHALL and SHOULD statements in the implementation guide for the
document body. Note that if a SHALL statement is nested under a SHOULD statement, it becomes a
SHOULD, (optional). For each statement, you will either be adding a section, or entering attributes
and constraints to build the public health case report.

From publichealthcasereport document in the template editor, right click to get the menu and then
select <CDA Tools> and then <Open Template Editor>

»Z:  Add UML »
»&2 Ty Filter View by Container
’:z “. Filter View by Resource

» B

bE’; Open With »
HL7 Tools »
CDA Tools » Open Template Editor

UML Extensions > Assign Rule I1Ds
T | Generate Sample Instance
Compare CDA Template Constraints

Figure 8 Open Template Editor

Because PHCR is a generalization from the CCD (Continuity of Care ) document, there may be
existing populated knowledge/requirements within the tool as a result. Select the code checkbox to
change the code as specified in the implementation guide, and click ok
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: 805 Template Editor 1
1 public health case report::publichealthcasereport |
§ extends cod::ContinuityOfCareDocument
|
| =] |
{ O [EL - classCode : ActClinicalDocument [0..1] = DOC [
) &) code : CE {C:LOINC#34133-9}
| =] [EZ - confidentialityCode : CE |
| ] EZ - copyTime : TS [0..1]
11O EZ - effectiveTime : TS |
| =] Ex-id:n
O @ languageCode : CS |
O [EL - moodCode - ActMood [0..1] = EVN i
[=] i - nullFlavor - MullFlavor [0..1] [
——————— —y FRES
' |
|
t
@ ( Cancel ) @€ oK 3
| A

Figure 9 Template Editor

The default value is what the CCD would specify. To change this, make sure you are on the code row
in the template editor. Then, in the properties explorer below, under the Properties tab, select the
General tab and change the Multiplicity to [1..1]

=] Properties &4 [3_\ Problems é Tasks | El Consale 2 ¥ =0

EL <<codeSystemConstraint>> <Property> code : CE

General Name: code
CDA Tools Business Name: code
HL7 Tools
PEAEAT Type: datatypes::CE Multiplicity: 1.1 E
Advanced Default Value:
[ Derived [ Read Only ™ Unique [ Ordered Aggregation: |none [*]

Figure 10 Properties Section

On the next tab - CDA Tools tab - is where you put vocabulary constraints. That is, the associated
LOINC code and its display name from Table 1

= properties 52 . [2{ Problems | ¥ Tasks | Bl Conscle =

2 <<codeSystemConstraint>> <Property> code : CE
Vocabulary Constraints

G |
gnera [ Concept Domain M Code System [ Value Set

CDA Tools

HL? Tools Code System

Documentation Select Code System... CodeSystems::LOINC

Advanced Name: | LOINC ID:  2.16.840.1.113883.6.1 Version:
Binding: [Static (Y] Code: |55751-2 Code Display Name:  Public Health Case Report
Validation
Severity: |SHALL : Rule ID{s): CONF-546 ] Mandatory

public health case report publichealthcasereport SHALL contain exactly one [1..1] code/@code="55751-2" Public Health Case Report {CodeSystem:
2.16.840.1.113883.6.1 LOINC) (CONF-546)

Figure 11 Edit Properties on CDA Tools Tab

There is a lot of content in CCD that is static - by using that as the basis for the model, we can hard
code many of the rules/constraints for the user of the template, and then only populate or change with
data that are dynamic
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To save, hit Ctrl S or go to menu, select File and then Save. You will be asked about additional

objects that have to be saved with the model. The application does a bit of work in the background
while saving.

Creating Section Templates

Now you can create the Public Health Social History section. As Table 1 shows, the implementation
guide states that there may be an optional PHCR Social history section, and if there is one, there are
further constraints specified for the content of the section. You have created a document template and
will now create an associated social history section template.

To create this section, go up to the root node, and from the right-click menu, create the template
through the <Add CDA> and then select <Template>

¥ public health case report.uml &3

Name Type Multiplicity | Annotation

M= _publ

. Add CDA » = Template
g4 Ts Filter View by Container Code System Version
Ec "% Filter View by Resource Value Set Version
(=1 z T T
Elp  Open With > 2.16.840.1
(=P 2.16.840.1
n = Copy
=E]
é{,f:: # Validate
in
B2
&F CDATools >
T
B

(CrdaSuctamcl

Figure 12 Add CDA Template or Section

You will get a New template screen

800 New Template

Enter template name

PHCRSocialHistorySection|

cancel ) (oK )

Figure 13 New Template Screen

After selecting OK, you will then get the Model Element Selection screen to allow you to select the
CCD template that your new template will be inheriting. Since the social history section is a section
that will be constrained beyond CCD Social History Section, the tool already has the CCD Social
History Section built in, so we can reference that. Scroll through and select the matching
SocialHistorySection and select OK
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[« NN &) Model Elernent Selection |

Choose an element:

Matching elements:

El spTCPatient

E Section

E ServiceEvent

E SeverityObservation

E SacialHistoryObservation

M socialHistorySection

E SocialHistoryStatusObservation

E Specimen m
E SpecimenRaole

Est .
E StatusObservation -

Owner:

Eccd - ccd-socialHistory.uml

@ ( Cancel :] E O 3

Figure 14 Model Element Selection Screen

There are additional constraints that we need to specify (e.g. in Table 1 above, there is a code and
title constraint.) To implement the constraints, on the Template Editor screen that displays next, select
the check boxes for code, and title to make sure they are required, then select OK.

800 Template Editor

pher_test:: PHCRSocialHistorySection
extends ccd::SocialHistorySection

I_EE classCode : ActClass [0..1] = DOCSECT
@ code : CE{C:LOINC#29762-2}

EZ confidentialityCode : CE [0..1]

EZ id : Il [0..1)

ET languageCode : C5 [0..1]

EZ moodCode : ActMood [0..1] = EVN

EZ nullFlavor : NullFlavor [0..1]

EZ realmCode : C5 [0..%]

I_EE sectionld : 5tring [0..1]

@ text : StrucDocText

& vitle : 5T

EZ typeld : InfrastructureRootTypeld [0..1)
/W socialHistoryObservation : SocialHistoryObservation [0..*]

Do0ROOOO0O0O00O0O®AO

@ [ Cancel j E—Ok—i

Figure 15 Template Editor Screen

Once they are added in the template editor, select each one, and enter the additional attributes - on the
Properties tab in the properties console. Enter the section title for the name and business name on the
properties tab. Then on CDA Tools, put in template ID, severity, etc.
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So now you have a new CDA template that was just created - PHCRSocialHistorySection. You now

need to be able to link this to the Public Health Case Report document, which you will do using an
association.

Creating an association

Once you have created section templates for the document, you will have to link them to the
document root. This will be through an association, which is used to create a relationship between the
root document, in this example the PublicHealthCaseReport, and the new section that you just
created, in this example the PHCRSocialHistorySection

In MDHT, you can create a relationship between 2 objects using either an association represented by

” A

a solid-headed arrow ( © ), or a generalization represented by an open-headed arrow (

An association represents the relationship of one section to another, e.g. a PHCR Social History
Section is associated to a Public Health Case Report

Whereas a generalization describes which template the current element is derived from, e.g. derived
from the CDA or the CCD

Therefore, to link the PHCR Social History Section to the document root, you will be creating an
association. To do this, select the root document, PublicHealthCaseReport in the template editor,
and then on the right click menu, <Add UML> and then <Association>. Templates are listed in
alphabetical order, so the document template might not be at the top of the templates list in the template editor.

= Attribute T
%s Filter View by Container " Association 2
‘%, Filter View by Resource # Operation

s

Open With b / Generalization
of Cut {7} Constraint |
= Copy
% Delete = Comment
[ ASSIgNING AUTAONTY: T
| Validate
Control...
HL7 Tools P ntain the template identifier 2.11
CDA Tools [=
UML Extensions |

LUITIITT WIEIIAMT. |

Figure 16 Add an Association

Then in the Association Selection screen, scroll through and select the new
PHCRSocialHistorySection. Note from Table 1 that this section is constrained as required under an
optional constraint. There is a nested SHALL statement beneath a SHOULD, which therefore
becomes a SHOULD because the parent constraint is optional. Meaning that if the parent component
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exists, then there shall be a social history section. Therefore, the association should have a

multiplicity of [0..1]

N NN Association Selection

Choose the association target:

Matching elements:

=
= Performer2

E Person

M b CRsocialHistorySection

E PhysicalExamination5ection

Elprve_Ts

E Flace m
B PlanOfCareActivity

B PlanOfCareActivityAct

E PlanOfCareActivityEncounter

E PlanOfCareActivityObservation i
E PlanOfCareActivityProcedure v

Owner:

E phcr_test - phor_test.umil

lf?::l .f: Cancel j ( oK )

Figure 17 Association Selection

Now that you have created the PHCRSocialHistorySection, you can create the associated entries for
that section as described in Table 1 above. You will create some observation entries that you will then

associate to the PHCRSocialHistorySection (similarly to the steps above for creating the
PHCRSocialHistorySection and association).

For example, to create the Geotemporal History Observation, repeat step 16 to create a template and
enter GeotemporalHistoryObservation as the template name.

Then on the Model Element Selection screen, select Observation as the matching element, and click

OK
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| @O Model Element Selection

Choose an element:

[ observation|

Matching elements:

E Observation
E ObservationMedia
Q ObservationRange

Owner:

] cda - cda.uml

@ [: Cancel :l E—H

4

Figure 18 Model Element Selection for Template

You will now select all the required elements from the Template editor as described in Section 4.14
of the implementation guide)

-8 O Template Editor

pher_test: CeotemporalHistoryObservation
extends cda::Observation

[Ed classCode : ActClassObservation

I:L—E code - CD

EZ derivationExpr - ST [0..1]

E effectiveTime - IVL_TS [0..1]

E2 id : 11[0..7]

EZ interpretationCode : CE [0..%]

EZ languageCode : C5 [0..1)

EZ methodCode - CE [0..*]

I_EE moodCode : x_ActMoodDocumentObservation A
EZ negationind : EBooleanObject [0..1) v

ODROCOOEO®E &R

®

(_ Cancel ) E'—Ok—'j

4

Figure 19 Template Editor

Once they are added in the template editor, you’ll see them listed as shown in the figure below
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¥ *pher_testuml 52

Narme Type Multiplicity Annotation Value
¥ T — | 5 [
[ QGeotemporaIHistnr\,'Observation 2.16.840.1.113883.10.20.15.3.
v ] PHCRSocialHistarySection
2 code Hce 1.1 @ cLoINC#29762-2
ELtitle st 1.1 @ sacial Histary
ELtext 5 StrucDocText 1.1l (%]
v /‘ geotemporalHistoryObservat Q CeotemporalHistor 0.1
L classCode @ HL7ActClass 1.1l @ 0BS
L code Heco 1.l @ cLoNC#s5210-9
1 effectiveTime Elvi_ts 0.1 A
[E2 moodCode @ HL7ActMood 1.1 @ EVN
[E4 statusCode Q s 1) @ C:HL7ActStatus#completed
L text Eep 0.1 @
EL value Q CcD 1.1 @ V:Geographical location histg
.4 /ccd::SociaIHistnrySeclion 2.16.840.1.113883.10.20.1.15
.4 Q PublicHealthCaseReport
P 5 ecd)

= - =

Figure 20 Model After Adding Required Elements

Select each one, and enter the additional attributes on the General and CDA Tools tabs in the
properties console that display below the template editor.

MZ' Task s} E.u Pruhlems} = Cunsnle}

s
i

B2 <<codeSystemConstraint, propertyValidation>> <Property> code : CE

| Vocabulary Constraints

Ceneral - ~
Q || Concept Domain @CudeSystem || Value Set

Figure 21 Entering Additional Attributes in Properties Section
To specify the multiplicity of the section or template you just added, you have to do that on the
association that allows the template to be integrated into the case report. This is done in the template
browser as shown in the picture below.

- ]

E PublicHealthCaseReport

2.16.840.1.113883.10.20.15
= Hce @ CLOINC#55751-2
/- pherSocialtistoryction _
b X pherClinicalinformationSectic Q F"hcr[hmcallnfnrma 1.1
b 7 pherTreatmentinformationSe Q PherTreatmentinfor 0..1 A
b 7 pherEncountersSection = PherEncountersSect 0..1 i
b 7 pherRelevantDyTestsSection Q PherRelevantDxTes 0..1 A
.

>

4 /f immunizationsSection E ImmunizationsSect 0..1

1721 DU B0 arardTarmat Analueic Nl

Figure 22 Adding Multiplicity to Associations

For example, to enter the multiplicity for the geotemporalHistoryObservation template, expand the
public health case report to show the associated templates. Select the
geotempoeralHistoryObservation association, which will have an association arrow in front of it, and
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Using MDHT Tool
enter the multiplicity in the multiplicity column of the template browser. Also select the CDA Tools

tab within the properties section, and enter a Type Code of “DRIV” for the association

¥ & phersacialHistorySection 2.16.840.1.113883.10.20.15.2,
L code Hce 1.1 @ c:LoINC#29762-2
Ea title EEst 1.1 @ social History
[CL text %'StrucDocText 1.1 @
*

b X geotemporalHistoryObservat QﬁentemparalHismr 0. /I DRIV {is derived from)

b X mostRecentTimeArrivedinUs/ = MostRecentTimeAr 0..1 DRIV {is derived from)

A raceObsenvation Q RaceObservation  0.* /A DRIV (is derived from)

¥ ¥ occupationObservation Q OccupationObserva 0..% /A DRIV (is derived fram)

b ¥ pregnancyObservation Q PregnancyObservat 0..* @ DRIV {is derived from)

> /7 ced::SocialHistorySection 2.16.840.1.113883.10.20.1.15
b = PhrTreatmentinformationSectia 2.16.840.1.113883.10.20.15.2.
> Q PregnancyObservation 2.16.840.1.113883.10.20.15.3.

g PublicHealt 2.16.840.1.113883.10.20.15

> Q RaceObservation 2.16.840.1.113883.10.20.15.3.
> Q ResultObservation 2.16.840.1.113883.10.20.15.3.
4 Q ResultOrganizer 2.16.840.1.113883.10.20.15.3.
> Q5ignsAndSymptums[Jbsenmion 2.16.840.1.113883.10.20.15.3.

= properties £3 . | Tasks | [£( Problems | B Console

/7 <<entry>> <Association> A_geotemporalHistoryObservation_phcrSocialHistorySection

Entry
Ceneral e
Type Code: DRIV (is derived from) |¥
CDA Tools
Documentation | asspciation Type: Y| Type Code: | |
Advanced Validation

Severity: |[SHOULD || Rule ID{si: CONF:1897, CONF:1898, CONF:1839

Figure 23 Editing Properties for Association

Once you’ve built all the section templates and have completed the model, the next step is to populate
that first project. This is done by building all the MDHT objects for your model.

Building all the MDHT objects for your model

Now that you have created your UML model, the building process can begin. Building auto-generates
all of the java artifacts to be used to create, validate, and digest a case report, and creates a human
readable version of the CDA from the generated java artifacts.

To start the build process, first save your model. Then, go to the main project folder and expand the

folder. Locate the transform.xml file in that folder (it’Il have an image %d of an ant next to it )
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r[\j Project Explorer 52 . = G:p ¥ =g
Lt L R T T T R L TP T T P TR W TR SN T =t
P =7 org.openhealthtools.mdht.uml.cda.hitsp.model 24!
> {3_-‘& org.openhealthtools. mdht.uml.cda.ihe 245 [https: )
I I=F org.openhealthtools. mdht.uml.cda.ihe.medel 245 |
bbénrg.npenheallhlools.mdhl,uml.cda,phcr
vb%crg.openhe:{lthlools.mdhl.urnl.cd:{.phcr_test
b =0, JRE System Library [|25E-1.5]
b =2, Plug-in Dependencies
b EHsrc
P (55 META-INF
F = model
fj. build.properties
plugin.properties
@transform,xml
- §= org.openhealthtools.mdht.uml.cda.pher_test.doc
¥ [=Forg.openhealthtools.mdht.uml.cda.phcr_test.mode
b—{35Urg.openhEallhlools.mdhl.uml.cda.phcr_testl '
= org.openhealthtools.mdht.uml.cda.pher_testl.doc v
R

E= == - o=

Figure 24 Running transform.xml

Right click on the file, and from the associated menu, select ‘Run As’ and then ‘Ant Build’ - (NOTE:
Select 1 Ant Build, not the 2nd one)

¥ g 0rg.openhealthtools mMant.uml.caa.pncr_test =100 e
» EJRE System Library [J25E-1.5] » E] publicHealthCaseReport
» i Plug-in Dependencies
»>
([Esrc New
P = META-IN
P& model | ghow In W
5 build.pre Open
5 plugin.p "
Open With g
b ;2 org.openhe = G
= Col ®#C
b [Zorg.openhe - Py #s
b fdorg.openhe = COPY Qualified Name
b iForg.openhe [ Paste 88y
¥ Delete =
3% Outline 5% _Remove from Context {38
I Mark as Landmark 0T serties |[21 Problems |4 Tasks | Bl Console
Build Path P ated> Publish CDA [Ant Build] /System/Libra
Move... [fop] WARNING: Page 14: Unresolved
Rename 2 |[fop] Dec 27, 2011 1:27:15 PM org.:

[fop] WARNING: Page 14: Unres:
[fop] Dec 27, 2011 1:27:15 PM '
[fop] WARNING: Page 15: Unresclved
e Export... [fop] Dec 27, 2011 1:27:15 PM org.:

[fop] WARNING: Page 15: Unresolved

£ Import...

2] Refresh F5 .fo2pdf.topic.fo:
lpdfa:
Open Javadoc Wizard... df2:
Run As » # 1 Ant Build
Debug As P % 2 Ant Build...
Team »
Compare With » External Tools Configurations...

Figure 25 Run As Ant Build Screen

You may get an Edit Configuration screen next. Click on the JRE tab and select the radial button
‘Run in the same JRE as the workspace’, then click ‘Apply’ and ‘Run’.

After the process finishes (building and saving...), return to the model folder and select the <project
name>.genmodel file from the model folder

v {37" org.openhealthtools.mdht.uml.cda.pher_test
P =54 JRE System Library [J25E-1.5]
P =5 Plug-in Dependencies
P Esrc
P (35 META~INF
¥ = model

1 pher_test_Ecore.uml|
b i pher_test.ecore
Fj build.properties
plugin.properties
& transform.xml

Figure 26 Select Genmodel
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Right-click on this file and select ‘Reload’ from the associated menu.

Yﬁorg.openheallhlools.mdhl,uml.cda,phcr_test m” > E PHCRSocia
b B JRE System Library [ Neow > il
» =, Plug-in Dependenci
> (B src Show In TEW >
» = META-INF Open .-
¥ & model Open With >
¥ phor_test_Ecore.t 1
> @ pher_test.ecore B Copy ®C
: -
@ build.properties ? Copy Qualified Name
plugin.properties 1] Paste *V
& transform.xml ¥ Delete [E
> = org.openhealthtools.m 3. Remove from Context (81
!l Mark as Landmark et
I= Outline &2 Build Path [ s
Move... P
Rename... F2 o
£y Import... 2
i Export...
2 Refresh F5 |
|
LCIGET I

Fvnnrt Madal

Figure 27 Reload Genmodel

In the Reload screen that will appear, you will accept all defaults and click on “Next’

806 Reload

Select a Model Importer E._"a
Create the Ecore model based on UML ar CMOF models T:'\

|

Model Importers:

H| Annotated Java
# Ecore model
@| Rose class model

™ UML madel

[5] XML Schema

@ < Bark [Next= ] [ cancel | Finish

Figure 28 Select a Model Importer Screen
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You will then get a “UML Import’ screen. You shouldn’t need to do anything special here. Accept the

defaults and click “Next”.

8no Reload
UML Import H-
Choose options, specify one or more Luml2', "uml’, ".xmi’, or ".cmof URIs, and try
to load them
Model URIs: | Browse File System... | | Browse Workspace... |
.=-platfurm:)‘resuuTcefﬂrg.up&nhaalthtonls.mdht.umi.cda.phcrlrmudel.rph:r_icure.uml Iﬂl
Options
Ecore Tagged Values Process il
Derived Features lanore [¥]
Duplicate Feature Inheritance Process ]
Duplicate Features Process ]
Duplicate Operation Inheritance Process []
Duplicate Operations Process [¥]
Redefining Operations Process il
| lgnore All | | Process All |

@ [ <Back | [Nemt»d] | cancel | Finist

Figure 29 UML Import Screen During Genmodel Reload

That will take you to a ‘Package Selection’ screen. If everything is setup correctly, you should only
see one package in the list of packages. Then select ‘Finish’

800 Reload
Package Selection gﬂ \
Specify which packages to generate and which to reference from
other generator models
Root packages: | Selectall | | Deselect All |
| F"-aci-iage |File Name
Iﬂ 4 org.openhealthtools.mdht.uml.cda.phcr pher.ecore
| Add... |

Referenced generator models:

"I ¥ f= Cda ('erg.openhealthtools. mdht.uml.cda' plugin)

E] & org.openhealthtools.mdht.uml.cda
¥ Pz Datatypes (‘'org.openhealthtools.mdht.uml.hl7.datatypes’ plugin)
A 1 nen anenhealthtnale mdht aml b7 datanmes
@ | < Back | MNext = | Cancel | [ Finish ]
W pEmt

Figure 30 Package Selection Screen During Genmodel Reload

Once the process completes, you will have the <project name>_Ecore folder open in the Template
Editor. Right click on this file and select ‘Generate Model Code *
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=40 pher.genmodel &3

‘ [B pher_Ecore ————————————————————————
pent Generate Model Code

Ii,(;cT Generate Edit Code
- Generate Editor Code
m Generate Test Code
salth Generate All

Open Ecore
Open GenModel

Figure 31 Run Ecore

After the process completes successfully, you will geta ‘BUILD SUCCESSFUL’ message. If not,
that means there is a problem that needs to be resolved with the model, so you’ll have to go through
troubleshooting steps. Once the model has been built successfully, this means that the model has now
been used to auto-generate the associated files. You can now browse the src folder that is created in
your project folder to see the java code that was generated for the project.

B sre

- EE org.openhealthtools. mdht.uml.cda.phcr_test

4 EE org.openhealthtools. mdht.uml.cda.pher_test.impl

- EE org.openhealthtools. mdht.uml.cda.pher_test.operations
EEE org.openhealthtools. mdht.uml.cda.pher_test.util

Figure 32 Folders Created from After Generating Model Code

Creating value sets and adding them to your model

The easiest way to start off adding value sets is to copy one of the vocab UML files from one of the
other project model folders that are in the project explorer.

¥z = org.openhealthtools.mdht.uml.cda.phcr.madel 65
¥ [ > model 653
EE, pher.properties 424
> 'E, > pheruml 653

;- > pher-vocab.uml 653

B L L L BT

Figure 33 Example of PHCR-vocab UML File

Copy this file and paste it in your model folder for the case report you are working on. Right-click
and rename the file using the naming convention <project root name>-vocab.uml. You will then be
modifying it to include the value sets that you require for your model.

Once you have the file copied, double click on it to open it for editing
It will open in the template browser.

Delete all the value sets that are listed by right clicking and selecting delete for each one until you
have no value sets listed in your <project>-vocab.uml file.
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Name Type Multiplicity
¥ Jihe-vocab
B ConcernEntryStatus -
> @ HealthStatusValue Add CDA 4
» & ProblemStatusValue Add UML >
» & SeverityObservation 2 Filter View by Container

B, . .
» 3. (CodeSystems) “1. Filter View by Resource

Open With >

of Cut
= Copy

Figure 34 Deleting Existing Value Sets from <proj>-vocab.uml

Then select the <old project name>-vocab listing that is the only entry left, and rename it by editing
the Properties tab on the bottom half of the screen

¥ “pertussis2-vocab.uml 2

Name Type Multiplicity

| Properties £3 ) Tasks | [2 Problems | & Console

Ea <Package> pertussis-vocab

General Name: pertussis-vocab

Documentation
Advanced

Business Name: pertussis-vocab

Figure 35 Renaming Root Name in Copied <project>-vocab.uml File

Now you’re ready to add in your value sets. Currently, you can only import value sets from the CDC
PHIN-VADS system. In order to import a value set, you must first download a zip file of the value set
from the https://phinvads.cdc.gov/ website. Note that at this time, 50 values is the size limit for value
sets that can be imported into MDHT.

Once you’ve downloaded the zip file for the value set, you’re ready to import the value set into
MDHT.

Right click on <project>-vocab file in the project browser and select OHT Model Tools, Import from
PHIN VADS
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W = org.openhealthtools.mdht.uml.cda.phcr.pertussis.model

Mame
TEge fl= condion_vocab |
pertusssuml T i » B NewValueSetVersionl
| b pertussis2-vocab.uml 4 1 =1 NewCode
» @ pertussis-vocab.uml New >

bLljdDrg.openheallhluuIs.mdhl_uml.cda.ph
b == org.openhealthtools.mdht.uml.cda.ph Open Model
» = org.openhealthtools.mdht.uml.cda.ph Open s F3
P:L'p‘JDrg.upenheallhluuIs.mdhl_uml.cda.ph Open With >
b == org.openhealthtools.mdht.uml.cda.ph -
b —org.openhealthtools.mdht.uml.cda.ph -=] COpV ®C
P:L'p‘JDrg.upenheallhluuIs.mdhl_uml.cda.ph Paste BV
» —*org.openhealthtools.mdht.uml.cda.ph 3 Delete =
b == org.openhealthtools. mdht.uml.cda.ph Move

=
b 2> org.openhealthtools. mdht.uml.cda.ph Rarates F2
» = org.openhealthtools.mdht.uml.cda.ph
P'BJDrg.upenheallhluuIs.mdhl_uml.cda.ph Expcrt to XMI...
> K healthtool dht.uml.cda.ph

L= org.openhealthtools.mdht.uml.cda p 229 Import...
b —org.openhealthtools.mdht.uml.cda.ph -
b == org.openhealthtools.mdht.uml.cda.ph e Export...
> org.openhealthtools.mdht.uml.cda.ph =

= & T - =
b = org.openhealthtools.mdht.uml.cda.ph i Refresh F5 5 properties 2% ¥4 Tasks [
b == org.openhealthtools.mdht.uml.cda.ph Validate pertussis2-vocab.uml - or
I‘L—éDrg.openhealthlooIs.mdhl_uml.cda.ph R A | |
P = org.openhealthtools.mdht.uml.cda.ph un As 5 F Resource BEOpe iy,
bh%nrg,openheal(hmols mdht.uml.cda.pil Dthg As L Vlnfz S|
» =3 org.openhealthtools. mdht.uml.cda.pil Team L e:irtI:EIe
PL—H—Drg.upenheallhluuIs.mdhl_uml.cda.re: Compare With > e (3 s s
> ii org.openhealthtools.mdht.uml.cdato,  Replace With [ linked
> L arg.openheaithtools.mdht.uml.cda. to QT T R T > Import from PHIN VADS
P{:m:Drg.openheal(h(ools.mdh(.uml.cda.tr: Source > T T =

Figure 36 Importing Value Sets into MDHT

You will get a file selection screen. Browse to the location for your downloaded value set zip file and
select the file. The process will run and the value set file will be imported. At the end of the process,
you should see a ‘BUIILD SUCCESSFUL’ message. You will have to troubleshoot the process if you
do not see this message.

Adding a New Value Set

If you’re adding a brand new value set that does not need to be imported, or adding a reference to a
value set that is too large to be imported into MDHT, then right click on the <project>-vocab and
select Add CDA, and then Value Set Version.

etk e,

Mame Type Multiplicity Annotation Valui
Bm ryvcondition-vocab L ——————————————————————————— ‘
Template
Add UML > [= Code System Version

T2 Filter View by Container = Value Set Version

¢, Filter View by Resource |3 T

Open With >
CDA Tools >
UML Extensions >

Figure 37 Adding a New Value Sset

Edit the value set information in the Properties tab by adding the value set name under General tab,
and the Code system, OID, Source, URL, and additional information under the CDA Tools tab.
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MName Type Multiplicity Annotation Value

= Properties £2 . ) Tasks| [£l Problems | Bl Cansole [

< <valueSetVersion>> <Enumeration> NewValueSetVersionl

Value Set Version
General

Select Code System... | | X
CDA Tools -

P Name: | NewWalueSetVersionl 1D

Advanced Full Name:
Source:

URL:

Type: |Intensienal [¥| Binding: |Static Y Version:

Release Date: Effective Date:

Definition:

Figure 38 Adding Definition to New Value Set

Now you’re ready to add values to the value set. Select the value set and right click and from the
menu, select Add CDA and then Value Set Code

Type Multiplicity Annotation

Add CDA
Add UML >
T2 Filter View by Container
“%. Filter View by Resource

= Value Set Code

Figure 39 Adding a New Code to a Value Set

You will get a NewCode entry added to the page. In the Properties section beneath the template
editor, enter the code in the Name field of the General tab, and add in the Code System, Concept
Code, Concept Name, and Usage Code on the CDA Tools tab. Select the ‘Add New Code’ button to
continue to enter the value set codes until you are done.

Publishing the implementation guide for your model

At the point that you have a valid MDHT model, after all errors have been correct, you can generate
the implementation guide automatically for your model. This steps provides you with a pdf that will
look like a typical implementation guide with all the constraints specified for your model.

Access your <project name>.doc folder, which contains all the dita files for generating the
documentation for your project

Right click on the dita-transform.xml file and select Run as Ant
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¥ [ org.openhealthtools. mdht.uml.cda.pher.pertussis.doc

4
4
4

=/ Copy
Paste
# Delete
Move...
Rename...

£2g Import...
<y Export..

&' Refresh

Validate
Open Javadoc Wizard...

Debug As
Team

Cammara With

[~rss

[~ dita

[= META-INF

@ build.properties
dita.properties

™ dita-transform.xml

@Penussis Case Report CDA R2_developer.pdf
fﬁPenussis Case Report CDA R2.pdf
plugin.properties

#C

#V I

[Ed

F2 s.model

llosis
llosis.doc

llosis.model

F5 doc

model

# 1 Ant Build
# 2 Ant Build...

>
>
4
S

Fxternal Toaals Cot

Figure 40 Running the Dita Transform

Using MDHT Tool

You may get a dialog box that asks you to choose an Ant configuration to run. Just accept the default
selection and hit OK

The process will run and if it completes successfully, you will get a “BUILD SUCCESSFUL”
message.

Now go to the dita folder and right-click on spec-book.ditamap and select MDHT from the
menu, and then select the Publish option
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|X| spec—web
E= META—INF
@ build.propen
dita.propertil
£ dita-transfor
% Pertussis Cas
% Pertussis Cas
plugin.prope

corg.openhealtht
corg.openhealtht
corg.openhealtht
org.openhealtht
corg.openhealtht
org.openhealtht
-org.openhealtht
corg.openhealtht
-org.openhealtht
-org.openhealtht
.org.openhealtht
-org.openhealtht
.org.openhealtht
corg.openhealtht

Figure 41 Running Publish Step for Implementation Guide
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Paste
# Delete
Mowve...
Rename...

E=g Import...
e Export...

2’ Refresh
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Run As

Debug As
Team
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Once this process completes successfully, you will get a ‘BUILD SUCCESSFUL’ message,
and the implementation guide will be generated and placed in the <project name>.doc folder
(you should find it listed under the dita transform (e.g. Pertussis Case Report CDA R2

developer.pdf)
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